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Chapter 1
IEC60730B Safety library example user's guide

For easier development of the IEC60730B application, the library also provides the example code. This example is distributed
through the MCUXpresso SDK website. This example user's guide describes how to set the hardware correctly and how to use
the example code with the IEC60730B Safety library.

The library user's guide is the main documentation for IEC60730B. It is also part of this package and you can download it at
www.nxp.com/IEC60730.
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Chapter 2
Hardware settings

This chapter describes how to set up the hardware of the evaulation board. The MCU peripherals' setup is described later on.
The IEC60730B library example for the Kinetis CM4 and CM7 family supports the following development boards:

+ FRDM-KV31f

+ FRDM-K22f

Torun the IEC60730B example application, it is neccessary to make some hardware settings. For the default configuration of your
development board, see the corresponding board's user manual at www.nxp.com.

2.1 FRDM-K22F

Debugger:
The default debugger in the example project is set to CMSIS-DAP.

FreeMASTER

FreeMASTER communication is used via an onboard debugger with a speed of 9600 bd.

There are no hardware settings necessary to run the IEC60730B example code.
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Figure 1. FRDM-K22F

2.2 FRDM-KV31f

Debugger:
The default debugger in the example project is set to CMSIS-DAP.

FreeMASTER

FreeMASTER communication is used via an onboard debugger with a speed of 9600 bd.

The IEC60730B example application was tested with the jumper settings shown in Figure 2.
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Figure 2. FRDM-KV31F
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Chapter 3
File structure

Safety is only a small part of the whole SDK package for your device. The IEC60730 library and examples are located in the

middleware and in the board folders. The IEC60730 library is independent of the SDK and can be used stand-alone.

3.1 Library source files location

The library source files are in the middleware/safety iec60730b/safety/v4_1 folder in the SDK package.

The folder has the following structure:

Where:

Mame
&L
[commaon_test]
[compiler]
[core_test]
| | IECBOT30B_M_MT_KEIL w4 _1
| | IECE0730B_M4_MT_COM_KEIL w4 1
| ] IECE0730B_M33_KEIL w4_1
| | IECBOT30B_M3I3_COM_KEIL v 1
| | IECBOT30B_MO_KEIL_wd_1
| | IECBOTI0B_MO_COM_KEIL wd_1
B iect0720b_types
B iect0720b
| | HbIECE0TI0B_MA_MT7_MCUK w4 1
| | HBIECE0T30E_M4_MT_COM_MCUX w41
| ] HBIECE0730B_M33_MCUX w4 _1
| | ibIEC&0T73I0B_M33_COM_MIUX_vd 1
| | ibIECE0TI0E_MO_MCUX _wd 1
| | liblIECEOTI0B_MO_COM_MCUX _wd 1
|| [ECB0730B_M4_MT_IAR w4 _1
| | IECE0730B_M4_M7_COM_IAR_v4_1
| | I[ECB0730B_M33_IAR w4 1
| | IECE0730B_M33_COM_IAR 4 _1
| ] IECE0730B_MOD_IAR w4 1
| | IECBOT30B_MO_COM_IAR wd_1

+Ext

lib
lib
lib
lib
lib
lib

=TI - TR - T - TR - TR - T - TR - T - TR ~ I TR =T R Sl

F T S S S

» common_test contains the source files for the “peripheral” test — this is a common cross core. These tests are compiled to
library liblIEC60730B_<core>_COM_<compiler>_<version>.a.

» compiler - compiler support files.

» core_test contains the source files for the core-dependent test. These tests are compiled to library

lIbIEC60730B_<core>_<compiler>_<version>.a.

* jec60730b.his the main library header file.

* jec60730b_types.his the header file with the necessary defines for the library.

The folder also contains binary */ib files which are compiled for the IAR, Keil, and MCUXpresso IDEs (see the release notes

for details).
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Example of library handling code

3.2 Example of library handling code

The library-handling code and the example aplication are separate from the library file. The example source files and other SDK
examples are at this path:

boards/<your board>/demo_apps/safety,_iec60730b/

The safety example code is shown in Figure 3.

+Mame Ext
&1
[iar]
| [Fcw]
[rndk]
B cafety_test_items h
B cafety_test_items c
o safety_iecB0730b
5 safety_config
5 safety_cml_lpc
5 safety_cml_lpc
=] readme
B project_setup_lpcxpressof45max
B oroject_setup_lpoxpressof45max

=
2

B pin_mux

B pin_mux

5 rmain

5 isr

5 freemaster_cfg
B clock_config
B clock_config
B board

B board

[Tl o T i i Sl o T o T IHH:'.':'.'

Figure 3. Example of project structure in example folder

This folder contains the example source file and three folders for the IDE project file:
> far
s mecux
* mdk
The following files are generated by the MCUXpresso configuration tool:
* clock_config.h
» clock_config.c
e pin_mux.c
e pin_mux.h

Other files are used only for safety examples and their contents are described in the next chapter.
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NXP Semiconductors 8




NXP Semiconductors

Chapter 4
Example application

The structure of the example is common in all supported IDEs (IAR, Keil, MCUXpresso).

) safety iecb0TI0b - IAR Embedded Workbench IDE - Arm 8.40.1

File Edit View Project J-Link Tools Window Help

DlonEa@ = A& DC LS Q> B rE L
debug w
Files O .
E @ salety_iecB0730b - debug ™ o

M board
El board.c e
}— B boardh
& B clock_config.c .
— B clock_config h
& B pin_muxc a
L— & pin_munch
2 B CMSIS
= B component -
-8 i_--
- [ startc *
& [ starup_jarc ™
& [ veciors_ianc ™
L Blwectars_iarh
2 W device
— [ fzl_denice_registersh
— B LPCE45h
t— [ LPCB45_featuras.h
& [ system_LFCE45 ™
— B system_LPCE45h
= B coc
—E B drivers .
& 8 FreeMASTER ®
3 B |EC60730_Class_B L]
&1 & source
— [ freemaster_cfgh
— Bliseh
&[] miain.c ™
8 [ project_setup_lpcxpressoBdSmaxc s
— Bl project_setup_lpopressoB4Smaxh
& [ satety_cml_lpcc ®
— [ safety_cmi_lpch
— [ safety_config h
= [ safety_test_ilems.c ™
—— ] safety_test_femsh
=& M utilties .
= & Qutput

Figure 4. 1AR example application structure

The project contains the CMSIS, SDK, library, and safety example-related folders.

The safety-related folders are the following:
» Board - this folder contains the files related to the board used (clock config.h, pin_config.h, board.h, and so on).
* CPU- this folder contains the startup code and vectors table.

* |[EC60730 _Class_B - files for the IEC60730B Safety library.

Kinetis CM4/CM7 Safety Example , Rev. 3, 07/2021
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How to open the project

» Source - source file for the safety example (see the next explanation).

The example of project hiearchy is shown in Figure 5.

isr.h
freemaster_cfg.h

safety_config.h > main.c

l l |

project_setup.c safety_cm0.c safety_test_items.c
project_setup.h safety_cm0_h safety_test_items.h

|

IECE0730 Class B library

Figure 5. Example of project hiearchy

Figure 5 shows that the functions in the project_setup.cfile are called from the main.cfile. The library-handling functions are
located in the safety_cm4_cm7_kinetis.c file and also called from the main.cfile.

The main example application header file safefy_config.h contains all definitions for running the safety test in examples. The
safety_test_items.cfile declares the structures for the DIO (or TSI) safety test. The project_setup_<your_board>.cfile contains the
setup functions (clock, port, UART, and so on). The safety_cm4cm7_kinetis.c file contains the handling function for safety routines
from the IEC60730B library and also the test-initialization function for safety.

4.1 How to open the project

IAR IDE
Open the project file located at boards/<your_board>/demo_apps/safety_iec60730b/iar/safety_iec60730b.eww.

Arm Keil IDE
Open the project file located at boards/<your_board>/demo_apps/safety_iec60730b/mdk/safety_iec60730b.uvprojx.

MCUXpresso IDE

Firstly, drag and drop the <name_of _the_package>.zip package into the MCUXpresso IDE (into the "Installed SDKs" tab).
Secondly, import the SDK example (safety_iec60730b).

Kinetis CM4/CM7 Safety Example , Rev. 3, 07/2021
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Example settings - safety_config.h

If you are not familiar with the MCUXpresso IDE yet, see docs/Getting Started with MCUXpresso SDK for <your_board>.pdf("Build
an example application" section).

4.2 Example settings - safety_config.h

The main example settings header file is safefy_config.h. The neccessary macros for the safety example are defined in this file.

The "switch macros", which enable the user to turn off the calling of the safety test, are defined in the beginning. When starting,
turn off the FLASH test and the WDOG test. On LPC devices, turn off also the Clock test.

/* This macro enables infinity while loop in the SafetyErrorHandling() function */
#define SAFETY_ERROR_ACTION 1

/* TEST SWITCHES - for debugging, it is better to turn the FLASH and WDOG ftests OFF. 7/
#define ADC_TEST_ENABLED 1

#define CLOCK_TEST_ENABLED 1

#define DIO_TEST_ENABLED 1

#define FLASH TEST_ENABLED 1

#define RAM_TEST_ENABLED 1

#define PC_TEST_ENABLED 1

#define WATCHDOG_ENABLED 1

#define FMSTR_SERIAL_ENABLE 1

Other defines are used to configure the safety test as a parameter to a function or to fill structures.

4.3 safety_test_items.c file

The safety test ifems.c and .Afiles are the configuration files for the DIO test.

The file contains the fs_dio_test <platform>_tlist of structures. The pointers to these structures are collected in the
dio_safety ftest itemsf] array, which is used in the example application.

fs_dlio_test t dio_safety ftest jtem_0 =

{

.gpio = GPIOA_BASE,

.pcr = PORTA_BASE, /* Base address of PCR register /

.pinNum = 5, .pinDir = PIN_DIRECTION_IN,

.pinDir = PIN_DIRECTION_IN,

.pinMux = PIN_MUX_GPIO,

¥

/*NULL terminated array of pointers fo dio_test _t ifems for safety DIO test */

fs_dlio_test_t *dio_safety_test items/] = { &dio_safety test_item_0, &dio_safety test item_1, NULL };

Kinetis CM4/CM7 Safety Example , Rev. 3, 07/2021
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Source file - safety_safety_cm4_cm7_<platform>.c/.h

4.4 Source file - safety_safety_cm4_cm7_<platform>.c/.h

The safety_cm4_cm7_kinetis.csource file and the corresponding * Afile contain a library handling function. Each function contains
a detection. If a safety error ocurrs, the SafetyErrorHandling() function is called.

Kinetis CM4/CM7 Safety Example , Rev. 3, 07/2021
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Chapter 5
Running example

For the first run of the example on your hardware, it is recomended to turn off Flash, WDOG, Clock, AlO, and DIO test. In the next
step, turn on step by step.

When the WDOG is turned off and a safety error happens, the example stays in an endless loop.

5.1 FreeMASTER monitoring

FreeMASTER is used as the external PC tool for real-time monitoring. FreeMASTER is also implemented in the IEC60730B safety
examples. For simplicity reasons, the MAP file is the source of the variable address. Before connecting FreeMASTER to your
application, make sure that the application is running.

Running FreeMASTER:

Download and install FreeMASTER from www.nxp.com/freemaster.
The example project is in the safety.pmp file. Open it.
Check the project settings for your application:
* Open "Project->Options ->MAP Files". It must point to your output files.

IAR IDE and ARM Keil IDE

Navigate to the boards/<your board>/demo_apps/safety iec60730b/<compiler>/<debug or release>/".outfile.

MCUXpresso IDE

Navigate to the <workspace>/<project name>/<Debug or Release>/<project_name>.axffile.

Options >

Comm MAP Fies ] Pack Dir] HTML Pages ] Demo Mode ] Views & Bars ]

Default symbol file: | Waridebug'safety_iec60730b out
File format: |Ell'|aﬁ' ELF with DWARF2/DWARF4 dbg format. J Edit
List of all valid

symbal files:

Note: The file selected in the list will be used as default symbol file
when the project is opened

Behawior
[
[+ List symbol emors (varables using undefined symbols)
* Mways { Except afterinitial project load

OK | Cancel

Figure 6. Example of setting MAP files for FRDM-KV11 board

» Open "Project ->Options ->Comm" and select a correct RS-232 connection and speed. The connection speed is in the
safety_config.hfile's "SERIAL_BAUD_RATE" macros. By default, this speed is set to 9600 bd.

Kinetis CM4/CM7 Safety Example , Rev. 3, 07/2021
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FreeMASTER monitoring

Options X

Comm | MAP Files | Pack Diri HTML Pages | Demo Mode | Views & Bars]

—Communication

@ RS232 Pot |COM_ALL v | |All COM prts will be scanned
Speed: (9600  v| Timeouts.. |
(" Plug-in module: | Ll
Connect string | Ll Configure |
[~ Save settings to projectfile [v Save settings to registry. use it as default

Communication state on startup and on project load
("~ Open port at startup
(@ Do notopen port at startup
{— Store port state on exit, apply it on startup

[ Store state to project file. apply upon its load Advanced...

OK Cancel Appls

Figure 7. Setting UART speed

Now you can connect to the development board by pressing "CTRL+G" or clicking the "GQO" button:
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Post-build CRC calculation

File Edit View Explorer Project Tools Help

f‘ i Tahoma ~ls = B F O F@E@

Y .
= JH|@| @D -~ : [
)

I @ start communication (Ctrl+G) @

Open port and and start )

| = Demo communication Name Value __Unit | Period

k¥ Demoreecoraer —-oafetyCommon.CPU_control_test_result 0x0 HEX 1000

q_sSafetyCommon.CPU_non_stacked_test_result 0xD HEX 1000
q_sSafetyCommon.CPU_primask_test_result 0x0 HEX 1000

| q_sSafetyCommon.CPU_req_test_result 0x0 HEX 1000
q_sSafetyClockTest.clockTestContext 102 DEC 100
q_sSafetyClockTest.clockTestExpected 102 DEC 1000
q_sFlashConfig.checksum16 0xe25b HEX 1000
q_sSafetyCommon.FLASH_test_result Oxe25b HEX 1000
q_sSafetyCommon.CLOCK_test_result 0x0 HEX 1000

| q_sSafetyCommon.DIO_input_test_result 00 HEX 1000
q_sSafetyCommon.DIO_output_test_result 0x0 HEX 1000
q_sSafetyCommon.DIO_short_test_result 0x0 HEX 1000
q_sSafetyCommon.AIO_test_result 0x704 HEX 1000
q_sSafetyCommeon.PC_test_result 0x0 HEX 1000
q_sSafetyCommon.RAM_test result 00 HEX 1000
q_sSafetyCommon.STACK_test_result 0x0 HEX 1000
q_sSafetyWdTest.watchdogResets 0 DEC 1000
q_sSafetyCommon.safetyErrors 0x0 HEX 1000

| EApplicat\on Ca.. E\r‘ariable Stimulus

Open port and and start communication MNot connected
Figure 8. Safety example FMSTR application

Usually, the AlO test is a number of results oscillating between 0x0 and 0x704 (test passed and test in progress).

5.2 Post-build CRC calculation

The post-build CRC calculation can be used in several ways, depending on the IDE's built-in options. In IDEs that do not have the
built-in options, use the SRecord tool.

SRecord is a standalone utility for memory manipulation. This utility and all information about it are available at Peter Miller's
http://srecord.sourceforge.net/ webpage.

In the SDK package, the SRecord tool is in the <sdk_pack>/fools/srecord folder.

In the IEC60730B Safety example, the SRecord tool is used for the post-build CRC calculations in the MCUXpresso and uVision
Keil IDEs.

In the IAR IDE, use the "ielftool" integrated feature.

The SRecord utility is used to calculate the post-build CRC without any changes. In the postbuild, an additional * batfile that uses
the SRecord tool is called.

NOTE
The invariable memory test can be turned off/on in file safety_config.hfile.

5.2.1 Postbuild in IEC60730B safety example

The approach with SRecord is used in the safety examples for the MCUXpresso and uVision Keil IDEs, when the post-build
command calls the crc-hex.batfile, which supports the CRC16 and CRC32 calculations.

The crc-hex.batfile is in your SDK package, in the <sdk_package>/middleware/safety_iec60730b/tools/crc folder.

The complete post-build command, which is used in the safety example to calculate CRC32 in the uVision Keil IDE is as follows:

Kinetis CM4/CM7 Safety Example , Rev. 3, 07/2021
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Post-build CRC calculation

AL\ \middleware\safety_iec60730b\tools\crc\crc_hex.bat
-.\..\..\.\boards\<sYOUR_BOARD>\demo_apps\safety_iec60730b\mdk\debug\safety_iec60730b.hex
-.\..\..\.\boards\<sYOUR_BOARD>\demo_apps\safety_iec60730b\mdk\debug\safety_iec60730b_crc.hex
-.\..\..\..\tools\srecord\srec_cat.exe -CRC32

"<YOUR_BOARD>" is the name of your SDK development board, e.g. "frdmk22f".

The first line is the path from the project root path (IDE project file) to the crc_hex.batfile. The other lines are the parameters for
the crc_hex. batfile.

The crc-hex.batfile has three mandatory parameters and one optional parameter:

» The first paramater is the path from the crc-hex.batfile to your application's * hexfile (safety_iec60730b.hex). It is the input
for the calculation.

» The second parameter is the path for the generated output file. This file (with the specified name) is stored as a result of
the script (safety_iec60730b_crc.hex) with the calculated CRC.

» The third parameter is the path from the crc-hex.batfile to the srec_cat.exefile.

» The fourth parameters is optional. When it is filled with"-CRC32", the result will be CRC32. Otherwise, the CRC16
calculation happens.

A dedicated structure in the input *hexfile is used to define the area where the CRC will be calculated. All necessary information
for the CRC will be read by the crc-hex.batfile from this structure.

Information table in the * hex file

It is necessary to add a dedicated marker structure to the memory *hexfile to use the presented crc-hex.batfile.
The presented crc-hex.batfile parses the last 16 bytes from the input *Aexfile to the found information table.
This information table must have a dedicated structure and it must be placed at the end of the input *Aexfile.

The structure of the information table is as follows:

/* The safety-related FLASH CRC value. */

fs_crc_t c_sfsCRC =

{

.ui16Start = OxA55AU,

.ui32FlashStart = (uint32_t)_ ROM_start__,
.Ui32FlashEnd = (uint32_t)&Load$$ER_IROM3$SLimit,
.Ui32CRC = (uint32_t)FS_CFG_FLASH_TST_CRC,
.Ui16ENd = 0x5AA5U

2

* Ox5AAS5 - the start/end marker for the information table

* ui32FlashStart - the start address for the CRC calculation
» ui32FlashEnd - the end address for the CRC calculation
* UiI32CRC - the seed value

This table must be placed at the end of the * hexfile. This can be assured by a linker script. The linker script depends on the IDE
used. The exact description for the supported IDE is in the following chapter.

Kinetis CM4/CM7 Safety Example , Rev. 3, 07/2021
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Post-build CRC calculation

5.2.2 Arm uVison Keil IDE postbuild CRC

The safety example in the uVision Keil used Srecord to generate the postbuild for the invariable memory test.
To use the presented crc-hex.batfile, it is necessary to have correct settings in the IDE.
From the start, all necessary settings are added in the example project by default:
» The Flash test is turned on in the safety_config.h file.
» The output *hexfile is turned on and the postbuild CRC is calculated by the crc-hex.batfile with the Srecord.

» The final post-processed image is downloaded to the ROM memory using the "Download" button.

5.2.2.1 Postbuild CRC settings

As mentioned in Postbuild in IEC60730B safety example , for the presented crc-hex.batfile, it is necessary to do some settings
also in the IDE.

1. Set the IDE to generate the output * hexfile. Go to "Options — Output" and check the "Create HEX File" box.
2. Enable the afterbuild options in "Options->User — After Build/Rebuild", check "Run #1", and fill it with the following command:

L. L.L.l..Imiddlewarelsafety_iec60730blfools|crclcrc_hex.bat
-.l.l....Iboards|<YOUR_BOARD>|demo_appslsafety_iec60730blmdkldebugldev_safety iec60730b.hex
-.L.l....1boards|<YOUR_BOARD>|demo_appslsafety _iec60730bimdkldebugldev_safety iec60730b_crc.hex
-..l.l..I..lfools|srecord|srec_cat.exe

The meaning of this afterbuild command is described in Postbuild in IEC60730B safety example .

The product of the postbuild operation with the crc-hex.batfile is the <your project name>_crc.hex edited file, which must be
loaded to the target. The best way to do this is to create a debug initialization file.

5.2.2.2 Debug initialization settings

By default, the uVision Keil IDE downloads the output file specified in "Options->output". Due to this, it is necessary to create an
alternative debug initialization file. In our case, a *hexfile with an added CRC is dedicated for the download to the target.
In the uVision Keil IDE, it is necessary to select the following options:

» "Options ->Debug->Initialization file" - fill it with the "safety_debug.ini" pattern.

» "Options->Utilities->Init File" - fill it with the "safety_debug.ini" pattern.

Use a text editor to create the safety_debug.inifile. Create an empty file, save it with the */n/extension, and copy the following
command into the file: "LOAD .\debug\<YOUR_PROJECT>_crc.hex INCREMENTAL".

This command loads the <YOUR_PROJECT>_cre.hexfile from the .Idebuglrelative path and this address is relative to the project
file (<YOUR_PROJECT>.uvprojxin the presented case). It means that the file is in the debug folder.

It is necessary to save this file to the project root path (to the folder with <YOUR_PROJECT>.uvprojx in the presented case).

After these IDE settings, the IDE calls the crec-hex.batfile after the build and it uses the alternative hex file
<YOUR_PROJECT>_crc.hex as the source for programming during the download.

5.2.2.3 Linker settings for information table

The crc-hex.bat postbuild file expects the information table at the end of the * Aexfile. For this purpose, it is good to define your
own section in the linker. In the uVision Keil IDE, it can be the following:

Kinetis CM4/CM7 Safety Example , Rev. 3, 07/2021
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Post-build CRC calculation

LR_IROM3 m_fs_flash_crc_start __size_flash_crc__{

; Safety-flash CRC region

ER_CRC (m_fs_flash_crc_start) FIXED (__size_flash_crc_)
{

*(.fishere)

}

}

Where "m_fs_flash_crc_start"and"__size flash_crc__" are the user-defined address. This address must be at the end of the flash.

After defining this section in the ROM, a correct structure must be defined in the C language:

/* The safety-related FLASH CRC value. */

fs_crc_t c_sfsCRC __attribute__((used, section(".flshcrc"))) =
{

.ui16Start = OxA55AU,

.Ui32FlashStart = (uint32_t)__ROM_start__,

.Ui32FlashEnd = (uint32_t)&Load$$ER_IROM3$S$Limit,
.UiI32CRC = (uint32_t)FS_CFG_FLASH_TST_CRC,
.Ui16ENd = 0x5AA5U

2

5.2.3 MCUxpresso postbuild CRC

NOTE

The invariable memoty test example uses the crc-hex.batfile for the post-build calculation, so this example does

not work on Unix/Mac operating systems.

To use the crc-hec.batfile in the MCUXpresso IDE, do some settings in the IDE.
1. Set the "Options — C/C++ Build — Settings — Build steps - Post-build steps" options correctly.
2. Set the debug sesion (or the GUI Flash tool) configuration correctly.

3. Put the "Information table" at the end of the invariable memory.

5.2.3.1 Post-build configuration

Itis necessary to set the post-build string, so go to the "Options -~ C/C++ Build - Settings — Build steps — Post-build steps" menu.

Copy and paste the following post-build string into it:

arm-none-eabi-objcopy -v -O ihex "${BuildArtifactFileName}" "${BuildArtifactFileBaseName}.hex"

${ProjDirPath}/crc_hex.bat -${ConfigName}/${BuildArtifactFileBaseName}.hex -${ConfigName}/$
{BuildArtifactFileBaseName}_crc.hex -tools\\srecord\\srec_cat.exe
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This string ensures that the MCUxpresso IDE generates a *hex file with the same name as your project. After this, call the
crc_hex.batfile with the correct parameters as follows:

« -${ConfigNamej}/${BuildArtifactFileBaseName}.hex - the path to your application *hex file.
« -${ConfigName}/${BuildArtifactFileBaseName}_crc.hex - the path to the generated * hex file with the CRC added.
= -foolsllsrecord|lsrec_cat.exe - the path to the screcat.exe utility.

Because the name of your poject is set as the "${BuildArtifactFileBaseName}" variable, this postbuild is independent on your
project name.

Resource
Builders

v C/C++ Build Configuration: Debug [ Active ] | | Manage Configurations...

Build Variables
Environment

Logging ¥ Tool Settings ~* Build steps Bukd Atiact | (5} Biniy Passers| O BworPassers
MCU settings

Settings Pre-build steps

Tool Chain Editor Command:

C/C++ General
MCUXpresso Config Tools

Project Natures Edit...
Project References Description:
Run/Debug Settings ]
>
Task Tags
Validation Post-build steps
Command:
at -5{ConfigName}/${BuildArtifact seName}.hex -§{ConfigName}/${BuildArtifactFileBaseName}_crc.hex -tools\\srecord\\srec_cat.exe
Edit...
Description:
Performing post-build steps ~
. Post-build steps X

Notes:
- Commands are executed by a Linux compatible shell
(not the Windows command processor).
- A comment character (#) disables ALL FOLLOWING COMMANDS.
- Enter one command per line.
- After editing, commands are concatenated with a ;' separator.

hrm-nnne—eabi—nhjcupy -v -0 ihex "${BuildArtifactFileName}" "${BuildArtifactFileBaseName}.hex"
${ProjDirPath}/crc_hex.bat -${ConfigName}/${BuildArtifactFileBaseName}.hex -§{ConfigName}/${BuildArtifactFileBaseName}_crc.hex -tools\\srecord\\srec_cat.exe

Figure 8. Configuration of post-build steps

5.2.3.2 Place information table

The crc-hex.batfile expects the information table in the last 16 bytes of the input *Aexfile. This table can be defined as the
following structure:

/* The safety-related FLASH CRC value. */

fs_crc_t c_sfsCRC __attribute__((used, section(".flshcrc"))) =

{
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.ui16Start = OxA55AU,

.Ui32FlashStart = (uint32_t)&__ROM_start__,
.Ui32FlashEnd = (uint32_t)&m_safety_flash_end,
.Ui32CRC = (uint32_t)FS_CFG_FLASH_TST_CRC,
.Ui16End = 0x5AA5U

3

Where "__attribute__((used, section(".flshcrc")))" is a directive for the linker script to place this strucuture to memory
section "flshcrc”.

MCUXpresso Linker settings

The structure definition in the above example expects memory section "flscrc" to be defined in the linker. This can be set as follows:

/* The safety FLASH CRC. */

.SEC_CRC m_fs_flash_crc_start : ALIGN(4)
{

FILL(Oxff)

KEEP(*(.flshcrc*))

} >MEM_FLASH

Where "m_fs_flash_crc_start" is the user-defined address, but this section must be placed at the end of the output *hexfile.

5.2.3.3 Flash loader configuration

It is necessary to set a correct output file for the download to the target. There are the following two ways to do this in the
MCUXpresso IDE:

1. Using the "Debug configuration".
2. Using the "GUI Flash Tool".
Debug configuration
» Create the debug configuration for your debugger.

» Open the "Debug Configurations" menu ("Run - Debug configuration") and select the "Startup" tab. In this tab, select
"Load Image -> Use File -> <YOUR_PROJECT_NAME_crc.heX'.

» This edited *hexfile is in the <workspace>/<your_project>/Debug/<your_project>_crc.hexfolder.

This can be set in the OpenSDA, CMSIS-DAP, or J-Link debuggers.

Kinetis CM4/CM7 Safety Example , Rev. 3, 07/2021
NXP Semiconductors 20




Post-build CRC calculation

u Debug Configurations

Create, manage, and run configurations

I HeRX| BV~

Name: ‘ fradmk22f_dev_safety_iec60730b JLink Debug

|5 Main | %5 GDB Debugger | %5 JLink Debugger | & GUI Flash Tool | Other Symbols | = Startup

4 Source| ] Common

C/C++ (NXP Semiconductors) MCU Applicat Initialization Cornmands &
[E] C/C++ Application [ Reset and Delay (seconds): 2
[E] C/C++ Attach to Application
[E] C/C++ Postmortem Debugger [ Hatt
[t] C/C++ Remote Application monitor reset
[£] GDEB Hardware Debugging
E} GDEB PEMicro Interface Debugging
v ﬂ GDB SEGGER Interface Debugging
frdmk22f_dev_safcty_iec60730b JLink Debi | | Load Image and Symbols
[ Java Applet [ Load image
[T Java Application . . .
& Launch Group O Use project binary:  frdmk22f_dev_safety_iec60730b.axf
= Launch Group (Deprecated) (®) Use file: ‘ Yworkspace_loc\frdmk22f_dev_safety_iec60730b"\Debug'frdmk22f_dev_safety_iec60730b_crc.hex) | Workspace... File System...
T Remote Java Application
> KL mogeoffset he: [ ]
] Load symbols
@ Use project binary:  frdmk22f_dev_safety_iecb0730b.axf
(O Use file: Workspace... File System...
Symbols offset (hex): l:l
Run Commands
[ SR S hd
< >
§ . Revert Apply
Filter matched 15 of 13 items
Figure 8. Using output *.hex file with calculated CRC in MCUXpresso IDE
Using GUI Flash Tool
Only the SEGGER J-Link probes in the GUI Flash Tool support *hex files.
In the GUI Flash Tool settings, select "Workspace — <Configuration> - <PROJECT_NAME>_crc.hex' file for download.
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38 Gul Flash Tool O X

GUI Flash Tool for: |
SEGGER J-Link probes
Program executable into flash frdmke17z_dev_safety_iec60730b_crc.hex

Target: MKE17Z256xxx7

Options 5
Probe specific options E

Interface | SWD v | Speed | auto ~
Target Operations

Select the target flash operation to perform

'Program . __Erasé | Resurrect locked Kinetis device|

Options

Select the options to apply sI
File to program | S{workspace_loc)\frdmke17z_dev_safety_iec60730b\Debug\frdmke17z_dev || Wmtspace,,.l File Sﬂystem ]
Format to use for programming @) hex bin :
Base Address 0x0

[“] Reset target on execution  [/] Halt target on execution

General Options

Flash programming tool options

I I T YT

Additional options l ‘

[CJRepeat on completion []Preview command [ Clear console

l Run... Cancel !

Figure 8. GUI Flash Tool - SEGGER J-Link
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Chapter 6
IEC60730B tests

The library contains the following tests:
* Analog I/O test
* Clock test
* CPU register test
+ Digital I/0 test
* Invariable memory (flash) test
» Variable memory (RAM) test
* Program counter test
+ Stack test
» Watchdog test
» Touch-sensing peripheral TSIv5 test

The following chapters describe each test with focus on the example application (debugging).

6.1 AIO test

The analog IO test procedure performs the plausibility check of the digital 10 interface of the processor. The analog 10 test can
be performed once after the MCU reset and also during runtime.

There are three values tested in the application:
* VrefH
» VrefL
» Bandgap

Ensure that the ADC peripheral is set up correctly before calling the AlO test. In some cases, it is necessary to connect this signal
externally (by a wire) to the corresponding pin. The test is perfomed in a sequence, as defined in the safety config.hfile:

/*ADC test /

{1

{(uint32_ADC_MIN_LIMIT(0), (uint32_)ADC_MAX_LIMIT(60)}, |
{(uint32_ADC_MIN_LIMITAADC_MAX), (uint32_t)ADC_MAX_LIMIT(ADC_MAX)},|
{(uint32_)ADC_MIN_LIMITAADC_BANDGAP_LEVEL_RAW),
(uint32_)ADC_MAX_LIMIT(ADC_BANDGAP_LEVEL_RAW)} }

#define FS_CFG_AIO_CHANNELS_INIT {6, 5, 4} /* ADC Channels for V_refi, V/_refh, bandgap */

An example of the setting is shown above. The "FS_CFG_AlIO_CHANNELS_/NIT"macro defines that the ADC channel 6 is tested
first, with the limits corresponding to VrefL (GND). Channel 5 is tested next, with the limits of VrefH (VCC). Channel 4 is tested
next, with the limits for the bandgap.
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6.2 Clock test

The clock test procedure tests the oscilator frequency for the CPU core in the wrong frequency condition.

NOTE
The default clock setting from the SDK library is used in the example. For a real application, ensure that the
reference clock source is not dependent on the primary (tested) clock.

6.3 CPU register

The CPU register test procedure tests all CPU registers for the stuck-at condition (except for the program counter register). The
program counter test is implemented as a stand-alone safety routine.

Some tests stay in an endless loop in case of an error, others return a corresponding error message.

6.4 DIO test

The Digital Input/Output (DIO) test procedure performs the plausibility check of the processor's digital 10 interface.

NOTE
Make sure that the time between the "set" and "get" functions is sufficient for the GPIO peripheral speed.

6.5 Invariable memory test

The invariable (Flash) memory test provides a CRC check of a dedicated part of memory. This test can be turned off in the
safety_config.hfile.

The test consists of the following two parts:

» Post-build CRC calculation of the dedicated memory.

* Runtime CRC calculation and comparison with the post-build result.
The post-build calculation is different for each IDE:

In the IAR IDE, the CRC is calculated by the IDE directly using the linker (see Options->Build Action). The Flash test is fully
integrated to the example project in the IAR IDE. It is necessary only to turn this test on in the safety config.hfile.

In the uVision Keil IDE, the CRC is calculated by the Srecord third-party tool, which is called from the IDE (see Options - User
— After Build) The Flash test is fully integrated to the example project in the uVison Keil IDE. It is only necessary to turn this test
on in the safety_config.hfile. In case of any issues, see Arm uVison Keil IDE postbuild CRC

In the MCUXpresso IDE, the CRC is calculated by the Srecord third-party tool. The user must do some additional steps. For more
information, see MCUxpresso postbuild CRC.

NOTE
The invariable memory test example uses the crc.batfile for post-build calculation, so this example does not work
on a Unix/Mac operating system.

NOTE
When you debug your application with the Flash test turned on, be careful when using the breakpoint. The software
breakpoint usually changes the CRC result and causes a safety error.

6.6 Variable memory test

The variable memory on the supported MCU is an on-chip RAM.
The RAM memory test is provided by the MarchC or MarchX tests.
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The test copies a block of memory to the backup area defined by the linker. Be sure that the BLOCK_SIZE parameter is smaller
than the backup area defined by the linker.

NOTE
This test cannot be interupted.

6.7 Program counter test

The CPU program counter register test procedure tests the CPU program counter register for the stuck-at condition. The program
counter register test can be performed once after the MCU reset and also during runtime.

NOTE
The program counter test cannot be interrupted.

6.8 Stack test

This test routine is used to test the overflow and underflow conditions of the application stack. The testing of the stuck-at faults in
the memory area occupied by the stack is covered by the variable memory test. The overflow or underflow of the stack can occur
if the stack is incorrectly controlled or by defining the "too-low" stack area for the given application.

NOTE
Choose a correct pattern to fill the tested area. This pattern must be unique to the application.

6.9 Watchdog test

The watchdog test provides the testing of the watchdog timer functionality. The test is run only once after the reset. The test causes
the WDOG reset and compares the preset time for the WDOG reset to the real time.

For this test to run correctly, it is necessary to keep the WDOG_backup variable in a part of memory which is not corrupeted by
the WDOG reset.

NOTE
Some debuggers do not allow the WDOG reset. Due to this, it is necessary to turn off the WDOG when debugging
the application.
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Chapter 7

Revision history

Table 1. Revision history

Revision number SDK Description

0 2.9.0 Intial release.

1 2.10.0 Change devices supported in SDK rel. 2.10.

2 2.10.0 Post-build description added.

3 - Version cover SDK 2.9 and SDK 2.10 release - document for web
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